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About this guide

A CAUTION! ABBREVIATED SAFETY ALERTS. Hazard symbols and hazard
types specified in procedures may be abbreviated in this document. For the
complete safety information, see the “Safety” appendix in this document.

IMPORTANT! Before using this product, read and understand the information in the
“Safety” appendix in this document.

Revision history

Purpose

Intended use

Revision Date Description

Initial release of document, applicable to 7300Plus
A January 2015 Real-Time PCR Instruments running Real-Time PCR
Software v2.4 or later.

The Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide provides
information about calibrating and maintaining the Applied Biosystems® 7300Plus
Real-Time PCR Instrument.

The Applied Biosystems® 7300Plus Real-Time PCR Instrument is a real-time nucleic
acid amplification and detection instrument that measures nucleic acid signals from
DNA or reverse transcribed RNA and converts them to comparative quantitative
readouts using fluorescent detection of dual-labeled hydrolysis probes.

The Applied Biosystems® 7300Plus Real-Time PCR Instrument is to be used only by
technologists trained in laboratory techniques, procedures, and on use of the analyzer.

Note: The manufacturer is not liable for damage or injury that results from use of this
manual by unauthorized or untrained parties.

Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide
For Research Use Only. Not for use in diagnostic procedures.
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Overview

B About the 7300Plus Instrument .......... ... . ... i 9
B Howtousethisguide ............. ... ... ... . ...l 11
B Recommended maintenanceschedule ......... ... ... ... ... oo 12
B Maintain the computer hard drive .............. ... ... ... .o oL 12
B Archiveand back up EDSfiles .............. ... ... ... ... L 13

Note: For more information about any of the topics discussed in this guide, access the
Help from within Real-Time PCR Software by pressing F1, clicking & in the toolbar,
or selecting Help » Real-Time PCR Software Help.

Note: The software information in this document is applicable to Real-Time PCR
Software v2.4 and later versions.

About the 7300Plus Instrument

About data
collection

Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide

The Applied Biosystems® 7300Plus Real-Time PCR Instrument is a 96-well, four-color
platform that uses fluorescence-based polymerase chain reaction (PCR) reagents to
provide:

* Quantitative detection of target nucleic acid sequences (targets) using real-time
analysis.

* Qualitative detection of targets using post-PCR (endpoint) analysis.

* Qualitative analysis of the PCR product (achieved by melt curve analysis that
occurs post-PCR).

The 7300Plus Instrument collects raw fluorescence data at different points during a
PCR, depending on the type of run that the instrument performs:

Run type Analysis Data collection point

Standard curve

Real-time Relative standard The instrument collects data after each extension
curve
runs step of the PCR.

Comparative Ct
(AACT)

For Research Use Only. Not for use in diagnostic procedures.



“v%4 Chapter 1 Overview
About the 7300Plus Instrument

Run type Analysis Data collection point

Genotyping The instrument collects data:

e Before the PCR. (For presence/absence
experiments, data collection before the PCR

Post-PCR is optional but recommended.)

(endpoint) ¢ (Optional) During the PCR. The instrument

runs Presence/absence can collect data during the run (real-time);

collecting data during the run can be helpful

for troubleshooting.

e After the PCR.

Regardless of the run type, a data collection point or read on the 7300Plus Instrument
consists of three phases:

1. Excitation— The instrument illuminates all wells of the reaction plate within the
instrument, exciting the fluorophores in each reaction.

2. Emission- The instrument optics collect the residual fluorescence emitted from
the wells of the reaction plate. The resulting image collected by the device
consists only of light that corresponds to the range of emission wavelengths.

3. Collection— The instrument assembles a digital representation of the residual
fluorescence collected over a fixed time interval. The Real-Time PCR Software
stores the raw fluorescence image for analysis.

After a run, the Real-Time PCR Software uses region of interest (ROI), optical, dye,
and background calibrations to determine the location and intensity of the
fluorescence in each read, the dye associated with each fluorescent signal, and the
significance of the signals.

About the filters The 7300Plus Instrument uses the following filters:

Filter 1 2 3 4

e FAM"dye| e JOE"dye | « TAMRA" dye o ROX" dye
Dye e SYBR® e VIC®dye | ¢ NED"dye e Texas Red ®
dye e Cy"3dye dye

For more For information on the 7300Plus Instrument and experiments performed using the
information Real-Time PCR Software, refer to the Real-Time PCR Software Help.

Note: To open the Help, select Help » Real-Time PCR Software Help in the Real-
Time PCR Software.

10 Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide
For Research Use Only. Not for use in diagnostic procedures.
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How to use this guide
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This guide describes how to calibrate and maintain the Applied Biosystems® 7300Plus
Real-Time PCR Instrument. Chapter 2, “Perform the Regions of Interest (ROI)
Calibration” through Chapter 5, “Verify Instrument Performance” of this manual
describe calibrations that you must perform as regular maintenance of the 7300Plus
Instrument. Chapter 6, “User-Performed Maintenance” and the appendices contain
maintenance procedures that you may need to resolve infrequent problems.

Chapter/ Appendix

Description

Chapter 2, “Perform the
Regions of Interest (ROI)
Calibration”

How to perform an ROI calibration, which allows the Real-
Time PCR Software to map the positions of the wells on
the sample block so that it can associate the fluorescence
collected during a run with specific wells of the plate.

Chapter 3, “Perform the
Background Calibration and
Optical Calibration”

How to perform background and optical calibrations
which allows the Real-Time PCR Software to remove
background fluorescence from experiment data.

Chapter 4, “Perform the Dye
Calibration”

How to perform dye calibrations, which allow the software
to distinguish the individual contribution of each dye in the
total fluorescence collected by the instrument.

Chapter 5, “Verify Instrument
Performance”

How to perform a TagMan® RNase P Instrument
Verification Plate run that can be used to verify the
performance of a 7300Plus Instrument.

Chapter 6, “User-Performed
Maintenance”

How to:

¢ Replace the user-serviceable parts of the 7300Plus
Instrument.

¢ Resolve infrequent problems that can occur during
instrument use.

Appendix A, “Store, Move,
and Install the 7300Plus
Instrument”

How to store, move, and reinstall the components of the
7300PLlus Instrument.

Appendix B, “Create a
Custom Dye Plate”

How to create a dye plate that can be used to calibrate the
7300Plus Instrument for a dye not manufactured by
Thermo Fisher Scientific.

Appendix C, “Create a
Background Plate”

How to create a background plate.

IMPORTANT! If you use and/or install the 7300Plus Instrument in an unspecified
manner, you may impair the protection provided by the equipment.

Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide
For Research Use Only. Not for use in diagnostic procedures.
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Recommended maintenance schedule

Recommended maintenance schedule

The following table displays the recommended maintenance schedule for the
7300Plus Instrument and computer. The procedures listed in the table are intended
for the user(s) of the 7300Plus Instrument. To ensure proper operation of your
instrument, perform the regular weekly, monthly, and semiannual maintenance
indicated below.

IMPORTANT! The numbered lists in the table below indicate that the tasks must be
performed in sequence.

Perform... User-performed maintenance task

e Check the computer disk space. If necessary, archive or back
up your experiment files.

e Power off the computer controlling the 7300Plus Instrument,
then after 30 sec, power on the computer.

Weekly e Clean the surface of the 7300Plus Instrument with a lint-free
cloth.

IMPORTANT! Do not use organic solvents to clean the 7300Plus
Instrument.

e Check the lamp status. If necessary, replace the halogen lamp.
Monthly  Perform a background calibration.["

e Run disk cleanup and disk defragmentation.

e Check the lamp status. If necessary, replace the halogen lamp.
e Perform a regions of interest (ROI) calibration.

Semiannually e Perform a background calibration.
(6 Months) e Perform an optical calibration.

e Perform a dye calibration.

e Perform an RNase P instrument verification run.

e Decontaminate the 7300Plus Instrument.
¢ Replace the Halogen Lamp.
As needed e Replace the 7300Plus Instrument fuses.

e Update the Real-Time PCR Software.

0 You can perform a background calibration to check for contamination. If any parts of the optics are replaced
or moved, you must run an ROI calibration, a background calibration, an optical calibration, a dye calibration,
and an RNase P instrument verification run.

Maintain the computer hard drive

When to * Atleast once every month

defragment the ¢ When a message is displayed by the Windows® operating system instructing you
hard drive to defragment

12 Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide
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information

Chapter 1 Overview %
Archive and back up EDS files [

In the desktop, select Start » Help and Support to access the Help for the Windows®
operating system. Use the search function of the Help to find information on the
“Disk Cleanup” and “Disk Defragment” utilities.

Note: Do not run the disk management utilities and Real-Time PCR Software at the
same time.

Archive and back up EDS files

Archive EDS files
regularly

Back up EDS files

Develop a data
management
strategy

Check disk space

To conserve space on the computer hard drive, older EDS files can be archived using
a data compression utility. Several commercially available compression utilities are
available. PKZIP and *.arc are archive formats common to the Microsoft® Windows®
operating system.

We strongly recommend that you back up your experiments.

Backing up data:

* Protects against potential loss of data caused by an unforeseen failure of the
computer or its hard drive.

¢ Conserves space on the hard drive and optimizes performance, if you remove old
data after backing up.

We recommend developing a strategy for managing the files produced by the Real-
Time PCR Software.

Note: Real-time runs generate significantly more data than genotyping or presence/
absence experiments. During one day of real-time operation, the 7300Plus Instrument
can generate more than 10 MB of data.

If you perform real-time experiments on your 7300Plus Instrument, check the amount
of available space on your hard drive weekly. When the hard drive is within 20% of
maximum capacity, transfer the older data to a backup storage device.

Note: You can perform a background calibration to check for contamination. If any
parts of the optics are replaced or moved, you must run an ROI calibration, a
background calibration, an optical calibration, a dye calibration, and an RNase P
instrument verification run.

Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide 13
For Research Use Only. Not for use in diagnostic procedures.
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Perform the Regions of Interest
[ROI) Calibration

B OVEIVIEW . oottt et e e e e e e e e e e 14
B Prepare the ROl calibrationplate .................... ... oot 15
B Perform the ROI calibration .......... ...ttt 17
B Unloadtheplate ....... ... ... .. 17
B Troubleshoot the ROI calibration ............ ... o ... 18

Note: For more information about any of the topics discussed in this guide, access the
Help from within Real-Time PCR Software by pressing F1, clicking & in the toolbar,
or selecting Help » Real-Time PCR Software Help.

A regions of interest (ROI) calibration maps the positions of the wells on the sample
block of the Applied Biosystems® 7300Plus Real-Time PCR Instrument. The Real-Time
PCR Software uses the ROI calibration data to associate increases in fluorescence
during a run with specific wells of the plate. The instrument uses a set of optic filters
to distinguish the fluorescence emissions gathered during runs. You must generate a
calibration image for each individual filter to account for minor differences in the
optical path.

Note: The ROI calibration is a user-performed maintenance procedure.

Around five minutes.

““i;’j; ;y/
ROI Calibration
Plate

Safety

> goggles Centrifuge with
Powder-free plate adapter
Real-Time PCR gloves
System Spectral
Calibration Kit

Applied Biosystems

Perform an ROI calibration:

* When installing the 7300Plus Instrument. You must perform in sequence the RO],
background, optical, and dye calibrations and the instrument verification run.

¢ Every 6 months, or as often as necessary, depending on instrument use.

¢ After replacing the lamp.

Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide
For Research Use Only. Not for use in diagnostic procedures.



Chapter 2 Perform the Regions of Interest (ROI) Calibration
Prepare the ROl calibration plate
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IMPORTANT! After every ROI calibration, you must perform a background
calibration, optical calibration, dye calibration, and instrument verification.

Prepare the ROl calibration plate

Standard plates

Prepare the plate

Use the Standard plates on your 7300Plus Instrument.

Standard Plates - 7300Plus Instruments

Notched corner at top right

A1
Al at corner : :
opposite = 1|:ID-_|..|L [
from N el maximum eI T
notched I||Jl|' ".III-IJI._IJ reaction II fif IU|I II.JI Il_|I ¥ II__. I
top-right IJIJUH - f .'IL'I u
comer (A12). "'IL'".;i | 'u'l Ju

Y]

Vortex standard plates to ensure complete mixing, then centrifuge to ensure that all
reagents are contained in the bottom of the well.

IMPORTANT! Wear powder-free gloves when you handle the ROI calibration plate.

1. Obtain the ROI calibration plate from the spectral calibration kit in the freezer.

2. Allow the ROI calibration plate to warm to room temperature (approximately 5
min).

IMPORTANT! Do not remove an ROI calibration plate from its packaging until
you are ready to run it. The fluorescent dye in the wells of the plate is
photosensitive. Prolonged exposure to light can diminish the fluorescence from
the plate.

3. Remove the ROI calibration plate from its packaging. Leave the optical film on
the plate.

IMPORTANT! Do not discard the packaging for the ROI calibration plate. The
plate can be used up to three times if it is stored in its original packaging sleeve.

|
\ |

JI

4. Vortex the ROI calibration plate for 5 sec.

Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide 1
For Research Use Only. Not for use in diagnostic procedures.
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W Chapter 2 Perform the Regions of Interest (ROI) Calibration
L2 Prepare the RO/ calibration plate

5. Centrifuge the plate for 2 min at 750 - 1000 g.

IMPORTANT! The ROI calibration plate must be well mixed and centrifuged.

6. Verify that the liquid in each well of the ROI calibration plate is at the bottom of
the well. If not, centrifuge the plate again at a higher rpm and for a longer period

of time.
Correct Incor rect
\ Liquid is at » Not centrifuged with enough force,
{ \ bottom of well. or
| » Not centrifuged for enough time
Load the plate WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the

sample block can be heated to 100°C. Before performing the following
procedure, be sure to wait until the sample block reaches room temperature.

1. Push the tray door to open it.

2. Load the plate into the plate holder in the instrument. Ensure that the plate is
properly aligned in the holder.

Load standard plateswith the
notched A12 position at
the top-right of the tray.

16 Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide
For Research Use Only. Not for use in diagnostic procedures.



Chapter 2 Perform the Regions of Interest (ROI) Calibration
Perform the RO/ calibration [

Perform the ROI calibration

Start the 1. In the Real-Time PCR Software, select Instrument » Instrument Maintenance
Calibration Manager.
2. In the ROI screen of the Instrument Maintenance Manager, click Start
Calibration.

3. Complete the calibration as instructed by the wizard.
The ROI Calibration dialog box displays three tabs:

* Setup - Displays instructions for setting up the ROI calibration. Clicking
Next opens the Run tab.

* Run - Clicking START RUN starts the calibration process and displays the
processing messages. Clicking Next opens the Analysis tab.

* Analysis — Indicates the calibration status (Passed/Failed).

If you cannot obtain a passing calibration, see “Troubleshoot the ROI calibration”
on page 18.

Unload the plate

i’i WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the
sample block can be heated to 100°C. Before performing the following
procedure, be sure to wait until the sample block reaches room temperature.

1. Remove the calibration plate:
a. Push the tray door to open it.

b. Remove the calibration plate.

c. Push the tray door to close it.

ﬁPush

2. Place the calibration plate inside its packaging sleeve. If you plan to perform
background and optical calibrations:

¢ Within the next 8 hr, keep the ROI calibration plate at room temperature.
The optical calibration uses the ROI calibration plate.

* On another day, return the packaged plate to the spectral calibration kit in
the freezer.

Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide 17
For Research Use Only. Not for use in diagnostic procedures.
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arQ . .
"5 Troubleshoot the RO/ calibration

IMPORTANT! Do not discard the calibration plate. If the plate is stored in its
original packaging sleeve, you can use it up to three times after you open it.

Continue with “Perform the Background Calibration and Optical Calibration”.

IMPORTANT! After you perform an ROI calibration, you must also perform a
background calibration (see page 20), an optical calibration (see page 25), dye
calibrations (see page 32), and instrument verification (see page 46).

Troubleshoot the ROI calibration

Observation Possible cause Recommended action
ROl calibration failed The sample block may be in 1. Check that the heated cover assembly is
its lowered position. pulled all the way forward to ensure that the

tray can be pushed in properly. If the
7300Plus Instrument has a heated cover
latch installed, check that the latch isin a
locked position.

AT
Heated cover

assembly

2. If the ROl calibration continues to fail, check
the status of the halogen lamp within the
7300Plus Instrument (see “Monitor the Lamp
Status”], then replace the lamp if necessary
(see "Replace the Halogen Lamp”).

18 Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide
For Research Use Only. Not for use in diagnostic procedures.



w288 Perform the Background Calibration
and Optical Calibration

B Perform the background calibration .................. ... ... o o 19
B Perform the background calibration ................... ... ... o o 20
B Prepare the background calibrationplate . ............................ ... 22
B Perform the optical calibration .................. ... ... ool 23
B Prepare the calibrationplate ............ ... ... ... ..l 24
B Perform the optical calibration .................. ... ... oo oL 25
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Note: For more information about any of the topics discussed in this guide, access the
Help from within Real-Time PCR Software by pressing F1, clicking & in the toolbar,
or selecting Help » Real-Time PCR Software Help.

Perform the background calibration

During a background calibration, the 7300Plus Instrument:
* Performs reads of a background plate containing PCR buffer for 10 min at 60°C.
* Averages the spectra recorded during the run and extracts the resulting spectral
component to a calibration file.

The Real-Time PCR Software then uses the calibration file during subsequent runs to
remove the background fluorescence from the run data.

Note: The background calibration is a user-performed maintenance procedure.

Time required 10 min
Materials Background
H Plate Safety
required e : goggles
N~
Applied Biosystems 7300Plus Powder-free Centricjé with plate

Real-Time PCR Instrument gloves adapter

Spectral Calibration Kit
Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide 19
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597 Chapter 3 Perform the Background Calibration and Optical Calibration

Perform the background calibration

When to perform Perform a background calibration:

the calibration .

When installing the 7300Plus Instrument. You must perform in sequence the RO],
background, optical, and dye calibrations and the instrument verification run.

Monthly, or as often as necessary, depending on instrument use.

After replacing the lamp.

Background Fluorescence data collected by the 7300Plus Instrument includes a fluorescence signal

fluorescence inherent to the system, referred to as background fluorescence. Background
fluorescence is a composite signal found in all spectral data. This signal consists of
fluorescence from several sources, including;:

Guidelines for .
calibration

Background electronic signal
Contaminants in the sample block

The plastic consumable (plates and caps)

Make sure the centrifuge you use is clean. Before centrifuging, wipe down the
bucket using a tissue.

Handle the calibration plates with care to prevent contamination. Do not place
plates on a lab bench, which may contaminate the plate. Always put calibration
plates back into their original bags.

Perform the background calibration

Prepare the plate

IMPORTANT! Wear powder-free gloves when you handle the plate.

1.

20

Obtain the prepared background plate from the spectral calibration kit in the
freezer.

Allow the background plate to warm to room temperature (at least 5 min).

Remove the background plate from its packaging.

IMPORTANT! Do not discard the packaging for the plate. The background plate
can be used up to three times if it is stored in its original packaging sleeve.

TSNS &F

Vortex the plate for 5 sec.

Centrifuge the plate for 2 min at 750 - 1000 g.

IMPORTANT! The plate must be well mixed and centrifuged.

Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide
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6. Verify that the liquid in each well of the background plate is at the bottom of the

well. If not, centrifuge the plate again at a higher rpm and for a longer period of
time.

IMPORTANT! Do not allow the bottom of the background plate to become dirty.
Fluids and other contaminants that adhere to the bottom of the plate can
contaminate the sample block and cause an abnormally high background signal.

Correct Incor rect
p Liquid is at » Not centrifuged with enough force,
/ { \ bottom of well. or

» Not centrifuged for enough time

Load the plate /\ WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the
sample block can be heated to 100°C. Before performing the following
procedure, be sure to wait until the sample block reaches room temperature.

1. Push the tray door to open it.

2. Load the plate into the plate holder in the instrument. Ensure that the plate is
properly aligned in the holder.

Load standard plateswith the
notched A12 position at
the top-right of the tray.

Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide 21
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Prepare the background calibration plate

Perform the 1. In the Real-Time PCR Software, select Instrument P> Instrument Maintenance
calibration Manager.

2. In the Instrument Maintenance Manager, select the Background tab.
3. In the Background tab, click Start Calibration.

4. Complete the calibration as instructed by the wizard.
The Background Calibration dialog box displays four tabs:
* Overview — Displays information describing the calibration.

* Setup - Displays instructions for setting up the background calibration.
Clicking Next opens the Run tab.

* Run - Clicking START RUN starts the calibration process and displays the
processing messages. Clicking Next opens the Analysis tab.

* Analysis — Indicates the calibration status (Passed/Failed).

If you cannot obtain a passing calibration, see “Troubleshoot the background
calibration” on page 27.

Note: Before starting the calibration, the instrument may pause (up to 10 min) to
allow the heated cover to reach temperature.

Unload the plate /\ WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the
sample block can be heated to 100°C. Before performing the following
procedure, be sure to wait until the sample block reaches room temperature.

1. Remove the calibration plate:
a. Push the tray door to open it.

b. Remove the calibration plate.

c. Push the tray door to move it into the instrument.

22 Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide
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Perform the optical calibration
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1

2. Place the calibration plate inside its packaging sleeve, then return the packaged
plate to the spectral calibration kit in the freezer.

IMPORTANT! Do not discard the calibration plate. If the plate is stored in its
original packaging sleeve, you can use the plate up to three times after you open
it.

If necessary, continue with“Perform the optical calibration” on page 25 .

You must perform an optical calibration (see “Perform the optical calibration” on
page 25), dye calibrations (see “Perform the dye calibration” on page 31), and
instrument verification (see Chapter 5, “Verify Instrument Performance”) if you are
performing the background calibration:

* As part of your semiannual maintenance

* After replacing or moving any parts of the optics

For more information, see “Recommended maintenance schedule” on page 12.

Perform the optical calibration

Time required

Materials
required

When to perform
the calibration

The optical calibration compensates for the physical effects of the optical system in the
7300Plus Instrument.

Note: The optical calibration is a user-performed maintenance procedure.
10 min

ROI calibration plate

Perform an optical calibration:

* When installing the 7300Plus Instrument. You must perform in sequence the RO],
background, optical, and dye calibrations and the instrument verification run.

¢ Every 6 months, or as often as necessary, depending on instrument use.

Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide 23
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Prepare the calibration plate

Prepare the plate

24

If you kept your ROI calibration plate at room temperature after performing an ROI
calibration (see Chapter 2, “Perform the Regions of Interest (ROI) Calibration”), skip
to step 5 to spin down any condensation that may have formed when the plate was at
room temperature. If the ROI calibration plate is in the freezer, go to step 1.

IMPORTANT! Wear powder-free gloves when you handle the plate.

1.

2.

Obtain the ROI calibration plate from the spectral calibration kit in the freezer.
Allow the ROI calibration plate to warm to room temperature (at least 5 min).

Remove the ROI calibration plate from its packaging.

IMPORTANT! Do not discard the packaging for the plate. The ROI calibration
plate can be used up to three times if it is stored in its original packaging sleeve.

Vortex the plate for 5 sec.

Centrifuge the plate for 2 min at 750 - 1000 g.

IMPORTANT! The ROI calibration plate must be well mixed and centrifuged.

Verify that the liquid in each well of the ROI calibration plate is at the bottom of
the well. If not, centrifuge the plate again at a higher rpm and for a longer period
of time.

Correct Incor rect

\ Liquid is at » Not centrifuged with enough force,
\ bottom of well. or

P AU

» Not centrifuged for enough time

Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide
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Load the plate WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the
sample block can be heated to 100°C. Before performing the following
procedure, be sure to wait until the sample block reaches room temperature.

1. Push the tray door to open it.

2. Load the plate into the plate holder in the instrument. Ensure that the plate is
properly aligned in the holder.

Load standard plateswith the
notched A12 position at
the top-right of the tray.

Perform the optical calibration

Perform the 1. In the Real-Time PCR Software, select Instrument P> Instrument Maintenance
calibration Manager.

2. In the Instrument Maintenance Manager, select the Optical tab.

3. In the Optical screen, click Start Calibration.

Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide 25
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o | Perform the optical calibration

4. Complete the calibration as instructed by the wizard.
The Optical Calibration dialog box displays four tabs:
* Overview — Displays information describing the calibration.

¢ Setup - Displays instructions for setting up the optical calibration. Clicking
Next opens the Run tab.

* Run - Clicking START RUN starts the calibration process and displays the
processing messages. Clicking Next opens the Analysis tab.

* Analysis — Indicates the calibration status (Passed/Failed).

If you cannot obtain a passing calibration, see “Troubleshoot the background
calibration” on page 27.

Note: Before starting the calibration, the instrument may pause (up to 10 min) to
allow the heated cover to reach temperature.

Unload the plate WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the
sample block can be heated to 100°C. Before performing the following
procedure, be sure to wait until the sample block reaches room temperature.

1. Remove the calibration plate:
a. Push the tray door to open it.

b. Remove the calibration plate.

c. Push the tray door to move it into the instrument.

;XPush

2. Place the calibration plate inside its packaging sleeve. Return the packaged plate
to the spectral calibration kit in the freezer.

IMPORTANT! Do not discard the calibration plate. If the plate is stored in its
original packaging sleeve, you can use it up to three times after you open it.

Continue with Chapter 4, “Perform the Dye Calibration”.

26 Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide
For Research Use Only. Not for use in diagnostic procedures.



N

-
=
v?e“

¥
=

7
ol

Chapter 3 Perform the Background Calibration and Optical Calibration
Troubleshoot the background calibration

2

)

Troubleshoot the background calibration

Observation Possible cause Recommended action
Background calibration failed One or more wells of the 1. Repeat the calibration using the same
background plate produced background plate.
spectra that exceed the 2. If the calibration fails again, repeat the
maximum limit for the calibration using a different background
instrument. plate.

3. If the calibration fails again, determine
the source of the contamination, as
explained in “"How to identify
contamination” on page 27.

How to identify Signals that exceed the limit of normal background fluorescence may indicate

contamination fluorescent contaminants on the calibration plate or the sample block. Common
contaminants include ink residue from permanent pens, powder from disposable
gloves, and dust.

To determine the source and location of the contamination:

1. While viewing the raw spectra, locate the contaminated well position(s) by
selecting successively smaller regions of the plate layout.

2. Rotate the background plate 180°, then perform the background calibration
again.

3. Repeat step 1 to locate the contamination. If the well position(s) of the
contamination in steps 1 and 3 are:

¢ Identical — The sample block is contaminated. Decontaminate the sample
block as explained in “Decontaminate the sample block” on page 50.

* Reversed — The background plate is contaminated. Discard the background
plate and perform the background run using a new background plate.
If the calibration fails after you replace the background plate and decontaminate
the sample block:
* Load a plate covered by a piece of black paper into the 7300Plus Instrument.
¢ Perform the background run as explained in this chapter.
e After the run is complete, select all wells of the plate layout.
¢ View the Spectral plot for the peak(s). If a peak is:

— Visible - The optics of your 7300Plus Instrument may be contaminated.
Contact Technical Support as explained in “Customer and technical
support” on page 83.

— Absent — The sample block is contaminated. Decontaminate the sample
block as explained in “Decontaminate the sample block” on page 50.

Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide 27
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Note: For more information about any of the topics discussed in this guide, access the
Help from within Real-Time PCR Software by pressing F1, clicking & in the toolbar,
or selecting Help » Real-Time PCR Software Help.

During a dye calibration, the Applied Biosystems® 7300Plus Real-Time PCR
Instrument:

¢ Collects spectral data from a series of dye standards.

* Stores the spectral information for the dye standards in a pure spectra calibration
file.

The software uses the pure spectra data during experiment runs to characterize and
distinguish the individual contribution of each dye in the total fluorescence collected
by the instrument. After each run, the Real-Time PCR Software receives data in the
form of a raw spectra signal for each reading. It determines the contribution of each
fluorescent dye used in the sample by comparing the raw spectra to the pure spectra
calibration data. When you save an experiment after analysis, the software stores the
pure spectra with the collected fluorescence data for that experiment.

Note: The dye calibration is a user-performed maintenance procedure.

1 hr

Dye Plates

(CY3°,FAM™, JOE™, NED", ROX", SYBR®
Green, TAMRA™, TEXASRED?, and VIC® dyes)

Powder-free Centrifuge with
gloves plate adapter

Note: If you store the dye calibration plates in their original packaging in the freezer,
you can use them to calibrate a 7300Plus Instrument up to 3 times for 6 months after
opening them.

Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide
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Chapter 4 Perform the Dye Calibration E&a=
Overview [ @i

Perform a dye calibration:

* When installing the 7300Plus Instrument. You must perform in sequence the RO],
background, optical, and dye calibrations and the instrument verification run.

e Every 6 months, or as often as necessary, depending on instrument use.

IMPORTANT! You must perform a background run before every series of dye
calibrations. Because the age and use of instrument components can affect pure
spectra readings, we recommend performing a dye calibration at least every 6
months.

The Applied Biosystems® 7300Plus Real-Time PCR Instruments use the following dye
sets for calibration: Cy"'3 dye, FAM " dye, JOE" dye, NED"" dye, ROX" dye, SYBR®
Green dye, TAMRA™ dye, TEXAS RED "dye, and VIC® dye. The following figure
shows the emission spectrum for each dye, and the filters and wavelengths at which
each dye is read.

Filters 1 2 8 4
| |
Spectrum 500 00 700
(nm) I I
Emission
Spectra

— ¢ O\ T

Pure Dyes ~520 nm ~550 nm ~580 nm ~610 nm
* FAM * JOE * TAMRA * ROX
* SYBR Green *VIC * NED « TEXAS RED
*CY3

The 7300Plus Instrument can be used to run assays designed with custom dyes (dyes
not supplied by Thermo Fisher Scientific). However, before using custom dyes with
the 7300Plus Instrument, you must create and run a custom calibration plate. The
Real-Time PCR Software uses the custom calibration plate to create a spectral
standard to distinguish the custom dye in the fluorescence data collected during the
run. See Appendix B, “Create a Custom Dye Plate” for information on custom dye
calibrations.

IMPORTANT! To use a custom dye on your 7300Plus Instrument, it must fluoresce
within the 520 to 650 nm spectral range measured by the 7300Plus Instrument.

The product of a dye calibration is a collection of spectral profiles that represent the
fluorescence signature of each dye standard. Each profile consists of a set of spectra
that correspond to the fluorescence collected from the wells of the spectral calibration
plate. The Real-Time PCR Software plots the resulting data for each spectral profile in
a graph of fluorescence versus filter.

When the Real-Time PCR Software extracts the calibration data from a dye run, it
evaluates the fluorescence signal generated by each well in terms of the collective
spectra for the entire calibration plate. Dye spectra are generally acceptable if they

Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide 29
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peak within the same filter as their group but diverge slightly at other wavelengths
(see below).

The Real-Time PCR Software can compensate for some differences in a spectral profile
by replacing (auto-repairing) the spectra of unacceptable wells with the spectra of
other wells on the reaction plate. However, the software allows only a few
replacements and may reject the calibration if the spectra between neighboring wells
vary significantly.

Note: Because the wells in a calibration plate contain dyes at identical concentrations,
the resulting signals for the wells containing each dye should be similar. Among wells
containing the same dye, variations in spectral position and peak position are caused
by minor differences in the optical properties and excitation energy between the
individual wells.

Acceptable Spectra Unacceptable Spectra

Analysis Data Analysis Data

Hormalized Fluorescence
Hormalized Fluorescence

Spectra peak at the same wavelength and | Spectra peak at the different wavelengths
do not diverge significantly

Prepare the dye calibration plates

IMPORTANT! Before performing a dye calibration, you must perform an ROI
calibration (see Chapter 2, “Perform the Regions of Interest (ROI) Calibration”), a
background calibration (see “Perform the background calibration” on page 20), and
an optical calibration (see “Perform the optical calibration” on page 25).

30 Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide
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Perform the dye calibration

IMPORTANT! Wear powder-free gloves when you handle the plate.

1.

Obtain the spectral calibration kit from the freezer, then remove all of the dye
plates.

Return the spectral calibration kit to the freezer.

Allow the dye plates to warm to room temperature (approximately 5 min).

IMPORTANT! Do not remove a dye plate from its packaging until you are ready
to run it. The fluorescent dye in the wells of each dye plate is photosensitive.
Prolonged exposure to light can diminish the fluorescence signal strength of the
plate.

Note: If you store the dye calibration plates in their original packaging in the
freezer, you can use them to calibrate a 7300Plus Instrument up to 3 times for 6
months after opening them.

Continue with “Perform the calibration” on page 31.

Perform the dye calibration

Perform the
calibration

In the Real-Time PCR Software, select Instrument P Instrument Maintenance
Manager.

In the Instrument Maintenance Manager, select the Dye tab.
In the Dye screen, select System Dye Calibration.
Click Start Calibration.

Complete the calibration for each plate as instructed by the wizard.

IMPORTANT! The wizard guides you through the calibration of each dye
separately. You must set up, run, and analyze each dye plate independently.

The Dye Calibration dialog box displays four tabs:

* Overview — Displays information describing the calibration.
When the software prompts you to obtain the required materials, select the
dyes that you want to calibrate.

* Setup - Displays instructions for setting up the dye calibration. Clicking
Next opens the Run tab.
When the software prompts you to load each dye plate, prepare and load the
plates as described in “Load a dye plate” on page 32.

* Run - Clicking START RUN starts the calibration process and displays the
processing messages. Clicking Next opens the Analysis tab.

* Analysis — Indicates the calibration status (Passed/Failed).

Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide 31
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When the software prompts you to analyze the spectra collected from each dye
plate, verify the status of the calibration:

¢ Passed — The 7300Plus Instrument passed the calibration. Go to “Analyze
the calibration data” on page 33.

¢ Failed — The 7300Plus Instrument failed the calibration. Troubleshoot the
error as described in “Troubleshoot the dye calibration” on page 36.

Note: Before starting the calibration, the instrument may pause (up to 10 min) to
allow the heated cover to reach temperature.
Load a dye plate Note: Because the wizard guides you through the calibration of each dye separately,

perform the following procedure for each dye that you calibrate.

1. Remove the dye plate that is specified by the software from its packaging.

IMPORTANT! Do not discard the packaging for the plate. The plate can be used
up to three times if it is stored in its original packaging sleeve.

2. Vortex the plate for 5 sec.

3. Centrifuge the plate for 2 min at 750 -1000 g.

IMPORTANT! The plate must be well mixed and centrifuged.

4. Verify that the liquid in each well of the plate is at the bottom of the well. If not,
centrifuge the plate again at a higher rpm and for a longer period of time.

Correct Incor rect
Liquid is at » Not centrifuged with enough force,

/ ( \ bottom of well. or
/ | * Not centrifuged for enough time

5. Verify that the dye plate that you are about to load matches the dye selected in
the Real-Time PCR Software.

Dye label

6. Push the tray door to open it.

32 Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide
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7. Load the plate into the plate holder in the instrument. Ensure that the plate is
properly aligned in the holder.

Load standard plateswith the
notched A12 position at
the top-right of the tray.

8. Close the tray door. Apply pressure to the right side of the tray door at an angle.

Note: If you cannot open the tray, the sample block may be in its raised position,
locking the tray position. To lower the block, select InstrumentCalibrate, then

exit the ROI Inspector.
Analyze the Note: Because the wizard guides you through the calibration of each dye separately,
calibration data perform the following procedure for each dye that you calibrate.

1. Verify the status of the calibration:

* Passed — The 7300Plus Instrument passed the calibration. Go to Analyze the
Calibration Data on page 33.

¢ Failed — The 7300Plus Instrument failed the calibration. Troubleshoot the
error as described in “Troubleshoot the dye calibration” on page 36.

2. Verify the grouping of the dye spectra:
a. In the plate layout, select the wells of the plate.

b. Inspect the raw data. For each spectrum, verify that the peak is:
e Within the detectable range for the 7300Plus Instrument.
* Free of irregular spectral peaks.
* Present in the correct channel for the dye (see Table 1).

If a spectrum does not match the criteria above, troubleshoot the problem as
described in “Troubleshoot the dye calibration” on page 36.

Note: Among wells containing the same dye, variations in spectral position
and peak position are caused by minor differences in the optical properties
and excitation energy between the individual wells.
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3. If all spectra are acceptable, then click Next.

Analysis

@ inotructions: Review e 6 specta e caloration passed, ik Nextio coninue. The resufs a0

sots: | EEEERE

Analysis Data

4. Remove the calibration plate:

@ WARNING! PHYSICAL INJURY HAZARD. During instrument
operation, the sample block can be heated to 100°C. Before performing the
following procedure, be sure to wait until the sample block reaches room
temperature.

a. Push the tray door to open it.
b. Remove the calibration plate.

c. Push the tray door to close it.

y Push

d. Place the calibration plate inside its packaging sleeve. Return the packaged
plate to the spectral calibration kit in the freezer.

Note: If you store the dye calibration plates in their original packaging in
the freezer, you can use them to calibrate 7300Plus Instruments up to 3 times
for 6 months after opening them.
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5. After you remove the dye plate as instructed, click Finish.

6. Prepare and run the next plate as explained in “Prepare the plates” on page 31.

Table 1 7300Plus Instrument dye spectra

Filter Peak (nm) Dye/Spectra
FAM™ dye SYBR® Green dye
1 ~520
JOE™ dye VIC® dye
2 ~550
Cy®3 dye NED" dye
M\
B
3 ~580 »
TAMRA" dye

Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide
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Troubleshoot the dye calibration

Filter

Peak (nm)

Dye/Spectra

ROX" dye TEXAS RED" dye

~610

Troubleshoot the dye calibration

Observation

Possible cause

Recommended action

One or more raw spectra are at .

or below the detectable
threshold

The spectral calibration
plate was centrifuged
insufficiently.

The spectral calibration
plate contains old or
insufficient reagents.

If you are running a
custom spectral
calibration plate, the dye
may not be present at a
sufficient concentration.

1. Unload the 7300Plus Instrument and view
the wells of the spectral calibration plate.
If the liquid in the wells is not:

a. Atthe bottom of the wells,
centrifuge the plate for a longer
time, then repeat the calibration.

b. Equivalent in volume, the plate is not
sealed and the reagents have
evaporated. Discard it and run
another.

2. |If the spectral calibration plate appears to
be normal, discard the plate and run
another.

3. If the problem persists, contact Support.

Note: If you are running a custom spectral
calibration plate, create another plate but
increase the concentration of the dye that
produced insufficient signal.

One or more raw spectra
exceed the maximum limit

or

The spectra contain peaks in
more than one filter.

Fluorescent contaminants
are on the sample block(s)
or spectral calibration
plate.

If you are running a
custom spectral
calibration plate, the dye
may be too concentrated.

Verify that contaminants are not present by
performing a background calibration as
explained in Chapter 3, “Perform the
Background Calibration and Optical
Calibration” If the background calibration does
not show sample block contamination, the
spectral calibration plate may be
contaminated.

Note: If you are running a custom spectral
calibration plate, create another plate but
decrease the concentration of the dye that
exceeds the detectable limit.

36
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Note: For more information about any of the topics discussed in this guide, access the
Help from within Real-Time PCR Software by pressing F1, clicking & in the toolbar,
or selecting Help » Real-Time PCR Software Help.

Perform the TagMan® RNase P Instrument Verification Plate run to verify the
performance of an Applied Biosystems® 7300Plus Real-Time PCR Instrument.

~1.5 hours
TagMan® RNase P
Instrument
Verification Plate
[ -
—3 /Y’
TagMan® RNase P Powder-free Centrifuge with plate
Instrument Verification gloves adapter
Plate Kit

We recommend performing an RNase P experiment:

When installing the 7300Plus Instrument. You must perform in sequence the RO,
background, optical, and dye calibrations and the instrument verification run.

After moving the instrument to another location.

As needed to verify the function of the 7300Plus Instrument.

37
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The RNase P plate is preloaded with the reagents necessary for the detection and
quantitation of genomic copies of the human RNase P gene (a single-copy gene
encoding the RNase moiety of the RNase P enzyme).
Each well contains:

¢ 1X TaqMan® Universal PCR Master Mix

¢ RNase P primers

e FAM'" dye-labeled probe

* Known concentration of human genomic DNA template

The figure below illustrates the arrangement of the standard and unknown
populations on the RNase P plate. The RNase P plate contains five replicate groups of
standards (1250, 2500, 5000, 10,000, and 20,000 copies), two unknown populations
(5000 and 10,000 copies), and negative control wells (NC).

1. 23 4 5 6 7 89 10 11 12

Unknown A
(5000)

NTC STD 1250 STD 2500
STD 5000 STD 10000 | STD 20000

Unknown B
(10000)

T & m m O O W >

After the run, the Real-Time PCR Software:

1. Generates a standard curve from the averaged threshold cycle (Cr) values of the
replicate groups of standards.

2. Calculates the concentration of the two unknown populations using the standard
curve.

3. Calculates the following to assess the 7300Plus Instrument performance:

[(Coprnk2) - 3(0C0prnk2)] > [(Coprnkl) + 3(GCoprnk1)]
where:

* CopyUnk; = Average copy number of unknown #1 (5,000-copy population)
® OCopyUnki = Standard deviation of unknown #1 (5,000-copy population)

¢ CopyUnk, = Average copy number of unknown #2 (10,000-copy population)
® OCopyUnk2 = Standard deviation of unknown #2 (10,000-copy population)

Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide
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Installation specification

The 7300Plus Instrument passes the installation specification if the inequality holds
and the instrument successfully distinguishes between 5,000 and 10,000 copies with a

statistical confidence level of 99.7%.

To meet the installation specification, you can omit a limited number of outlier wells

from the 5,000- and 10,000-copy unknown populations.

Unknown population

can be removed

Standard Negative
5,000-copy 10,000-copy (STD) controls (NC)
Maximum outliers that 6 6 0 0

Set up the experiment

Prepare the TagMan® RNase P Instrument Verification Plate for the run.

Prepare the IMPORTANT! Wear powder-free gloves when you handle the RNase P plate.

RNase P plate

1. Obtain the TagMan® RNase P Instrument Verification Plate from the freezer,
then allow the reaction plate to warm to room temperature (for approximately 5

min).

2. Remove the RNase P plate from its packaging.

3. Vortex the plate for 5 sec.

4. Centrifuge the reaction plate for 2 min at 750 - 1000 g.

IMPORTANT! The reaction plate must be well mixed and centrifuged.

Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide
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5. Verify that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the reaction plate again at a greater rpm and for a longer time.

IMPORTANT! Do not allow the bottom of the RNase P plate to become dirty.
Fluids and other contaminants that adhere to the bottom of the reaction plate can
contaminate the sample block(s) and cause an abnormally high background

signal.
Correct Incor rect
Liquid is at * Not centrifuged with enough force,

/ ( \ bottom of well. or
' | » Not centrifuged for enough time

Run the experiment

After preparing the TagMan® RNase P Instrument Verification Plate, load the plate
into the 7300Plus Instrument and start the run.

Load the plate WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the

sample block can be heated to 100°C. Before performing the following
procedure, be sure to wait until the sample block reaches room temperature.

1. Push the tray door to open it.

2. Load the plate into the plate holder in the instrument. Ensure that the plate is
properly aligned in the holder.

Load standard plateswith the
notched A12 position at
the top-right of the tray.
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Analyze the experiment

Start the run 1. In the Real-Time PCR Software, select Instrument » Instrument Maintenance
Manager.

2. In the Instrument Maintenance Manager, select the RNase P tab.
3. Inthe RNase P screen, click Start RNase P Run.

4. Complete the calibration as instructed by the wizard.
The RNase P dialog box displays four tabs:
® Overview — Displays information describing the calibration.

¢ Setup - Displays instructions for setting up the RNase P run. Clicking Next
opens the Run tab.

® Run - Clicking START RUN starts the run process and displays the
processing messages. Clicking Next opens the Analysis tab.

e Analysis — Indicates the run status (Passed/Failed).

Note: Before starting the run, the instrument may pause (up to 10 min) to allow
the heated cover to reach the correct temperature.

1 7 ot mswumen_snarsis_Toon_tep

New Experiment = . Open.. Wl J Cose & e

aiform an RNase P 1un to verity e parformance of your Instrument syst

o system.
To perform a new RNase P run, click “StatRNase P Run” To open an existing RNase P run, browse and seiect the file 1o open, then click “Opan”

oR RNase PRun |3t - Browse | | open |

RNase P Run Data

Background

LsstRun 104807 134 AM
Eip Date  41B0E134AM

Optical
Stats
LastRun. 10807 1354
Eqp Date  4NGOS13ISAM

- Systam Dys -
St

LastRun 10807 204 A
Ep Date  41808204AN
- Custom Dye -
Status ]

® Insirument Maintenance -
7500 connected

Analyze the experiment

Review the data to verify the results of the experiment.
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Verify the results Note: After the Real-Time PCR Software completes the RNase P run, it automatically
of the analysis analyzes the run and displays the results in the Analysis screen.

1. In the Analysis screen of the RNase P Run wizard, verify the status of the run:
¢ Passed — The 7300Plus Instrument passed the RNase P run. Go to Verify the
Results of the Analysis on page 43.

¢ Failed — The 7300Plus Instrument failed the RNase P run. Go to step 2 to
review the data for outliers.

If the run fails, the automated analysis may have included outliers that caused
the initial analysis to fail. Experimental error may cause some wells to be
amplified insufficiently or not at all. These wells typically produce Ct values that
differ significantly from the average for the associated replicate wells. If included
in the calculations, these outlying data (outliers) can result in erroneous

measurements.

2. In the Amplification Plot, select Ct vs. Well from the Plot Type drop-down list.

3. Verify the uniformity of each replicate population on the reaction plate (controls,

standards, and unknowns) by comparing the groupings of Crvalues:

a. In the plate layout, select the wells containing the 10,000-copy unknown
population (wells rows F, G, and H).

1.2 3 5 6 7 8 9 1o 11 12
Unknown A
(5000)
NTC STD 1250 STD 2500
STD 5000 STD 10000 | STD 20000

T @ m m O O W >

Unknown B
(10000)

b. In the plot, verify that the Crs of the replicate population are equivalent.

Note: The numbers on the X-axis of the plot correspond to the wells of the
reaction plate. Beginning with well Al, the wells are numbered from left-to-
right, and top-to-bottom.

c. If an outlier is in the selected population, select the corresponding well in
the plate layout, then click Omit to remove the well from the analysis.

Unknown population Standard Negative
5,000-copy | 10,000-copy (STD) control (NC)
Maximum outliers
that can be 6 6 0 0
removed

IMPORTANT! If the number of outliers exceeds the limit in the table above,
order another RNase P plate and repeat the experiment.

42
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Analyze the experiment

d. Repeat steps 3a through 3c for each replicate population (unknowns,

standards, and negative controls) on the reaction plate.

4. Click Reanalyze to analyze the run without the outliers.

If the status of the RNase P Run is “Failed” after performing steps 2 through 4,
repeat the RNase P experiment using a different RNase P plate. If the problem
persists, contact Support.

m R Amplification Plot] Standard Curve
Plot Settings
Plot Typei[CTvs Well %] Graph Type| Plot Color: jwell
2 ——
L( I
- A P alpg R E
(ar)
c\BIy o
N Amplification Plot
100
. ‘ -
Outlier £ r — --.-...,.............Q'
10 - p—
REEEEE R Lk X
Well Number
Options "\
Target Riase P % Threshold: e
& 1M >

Rhase P Analysis

3]

Analysis Help @)

apply the results

Status: Passed

B instructions: V12w {he resuls fiom the Ridase P run. if e run failsd, omit outiars, then click “Reanalyzs” Repeat unilthe run passes. Click Fnish to save and

<| View Plate Layout ] F.esvji!sg

>

)
(3c)(4)
Selact Wells With: - Selectten> /[ \ ™" /

how in Wells ¥ [ mvm«muend [

ElEE

5 7 8 8 10 11 12|

aooooooooac

W |m |w [= |5 )= = |5 5[5

QQaaooaaaaan

Qoooo.-.aaoan
L |

welis: [1] 72 Unknown [ 20 Standard [J] 4 Negative Control

0 Empty

cancel | | Previous | | Newt | | |

5. Review the standard curve:

a. Select the Standard Curve tab.

b. Click the upper-left corner of the Plate Layout to select all wells.

c. Verify that the R? value is greater than or equal to 0.990.

If the R? value is less than 0.990, repeat the RNase P experiment using a different
RNase P plate. If the problem persists, contact Support.

5a

5b

5c

RNase P Analysis Analysis Help )

@ istructions:

Status: Passed

and apply the results

Review the results from the RNase P run. Ifthe run failed, omit outliers, then click"Reanalyzs * Repeat until the run passes. Click Finksh o save

Omt || Rearaiyze | Anaiysis Setings |

Em

Targst Al v

Standard Curve

“Plot Sefiings

<[ View Plate Layout L R
bl

Select Wells With: - Select ftem - 3

|

Plot Color Dafault v ‘

[Boweniss [ Bweir] B[

mmpm.mzmdur % 93.012 -

|l standara [l Unknown [l Unknown (Flagoe s

Standard Curve

Quantity

28 8 2 A A
InDOOooooono
78 0 O A A

0000000000

U |

= walls: [I] 72 Unknown [ 20 Standard [] 4 Negative Control © Empty

Cancel | | Previous | | Mext |
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6. Click Next, then remove the calibration plate.

WARNING! PHYSICAL INJURY HAZARD. During instrument
operation, the sample block can be heated to 100°C. Before performing the
following procedure, be sure to wait until the sample block reaches room
temperature.

a. Push the tray door to open it.

b. Remove the calibration plate.

c. Push the tray door to move it into the instrument.
7. Discard the plate.

8. Click Finish, then click Yes when prompted to save the experiment.

Troubleshoot the RNase P experiment

Observation Possible cause Recommended action
More than the maximum e Possible contamination Contact the service and sales representative to
number of outliers are « Pipetting inaccuracy order a replacement TagMan® RNase P
present in RNase P data Instrument Verification Plate. If the replacement
RNase P plate fails, contact Support or your
service representative for further assistance.
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Observation

Possible cause

Recommended action

Verification run failed

Insufficient
centrifugation

Defective plate seal

1.

WARNING! PHYSICAL INJURY HAZARD.
During instrument operation, the sample
block can be heated to 100°C. Before
performing the following procedure, be
sure to wait until the sample block reaches
room temperature.

Unload the RNase P plate from the
instrument:

Push the tray door to open it.

b. Remove the RNase P plate from the
tray.

c. Push the tray back into the instrument.

2. Hold the plate up to a light source, and verify

that all wells contain the same volume of
fluid.

If there are differences in fluid volumes,
check the heat seal of the wells with lower
volumes for signs of damage or evaporation.

Also, compare the position of the wells that
have lower volumes with the outliers that you
have removed from the plate. If the well
positions coincide, the heat seal on the plate
may be defective and resulted in the
evaporation of the associated samples.

Contact the service and sales representative
to order a replacement TagMan® RNase P
Instrument Verification Plate. If the
replacement RNase P plate fails, contact
Support or your service representative for
further assistance.

Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide
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User-Performed Maintenance

B Monitor the 7300Plus Instrument ............ ... ... .. ... ... L 46
B Decontaminate the sampleblock ................... ... ... ... .. 50
B Replacethehalogenlamp .......... ... .. ... ... .l 54
B Replace the instrument fuses .................. ... ... . ... 56
B Update the Windows Operating System ................................. 58
B Update the Real-Time PCR Software ............ ..., 58

Note: For more information about any of the topics discussed in this guide, access the
Help from within Real-Time PCR Software by pressing F1, clicking & in the toolbar,
or selecting Help » Real-Time PCR Software Help.

Monitor the 7300Plus Instrument

View the
Instrument log

46

You can monitor the state of the Applied Biosystems® 7300Plus Real-Time PCR
Instrument using the Function Test, Lamp Status/Replacement, and Instrument Log
tools of the Real-Time PCR Software. The tools enable you to assess the health of the
7300Plus Instrument, check the replacement status of the instrument lamp, and view a
recent history of instrument activity.

Use the Instrument Log to view the recent event history of the 7300Plus Instrument.
The log displays the major instrument activity for either the most recent 25 runs
(including calibrations), or the events that pertain only to a specific EDS file.

Display the Instrument Log

1. In the Real-Time PCR Software, select Instrument » Instrument Events Log.

2. In the Instrument Events Log dialog box, select either:

¢ System Log — To view events that occurred during the 25 most recent runs
(experiments) or calibrations.

¢ Document Log — To view events that pertain only to the experiment
currently open in the Real-Time PCR Software.

Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide
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R

3. If necessary, modify the data displayed in the table by filtering the data and
adding or removing columns.

To...

Action

Filter the data in the
events table

In the Filter drop-down list, select a property.

2. Enter the appropriate conditions into the drop-
down lists and fields that appear automatically.

3. Click Apply to filter the data.

Note: To reset the log, select Filter » Show All
Records.

Add or remove columns
to/from the events table

Click Show Columns, then select the column desired
column in the drop-down list.

Sort the data in the events
table

Click the heading of the column of interest once to sort
the data in ascending order. Click the column heading
again to sort the data in reverse order.

Export the contents of the
instrument event log

Select the rows of interest in the event table,

2. Press Ctrl+C to copy the data.

3. Paste the data into a spreadsheet application or a
text file.

Note: The software exports the data in tab-delimited
format.

4. When you finish viewing the events, click Close.

Monitor the Use the Function Test dialog box to perform a high-level diagnostic of the major

instrument status  7300Plus Instrument components. In general, you need not perform the function tests
unless you experience a suspected hardware failure, or you are instructed to do so by
an Thermo Fisher Scientific representative.

Perform function tests of system components

1. In the Real-Time PCR Software, select Instrument » Function-Test.

2. Perform function tests as needed.

To test:

¢ All system components — Click All Tests, then wait for the software to
perform all of the function tests.

Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide 47
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Monitor the 7300Plus Instrument

One or more specific components — Click one or more of the following.

USB - Tests the universal serial bus (USB) connection between the 7300Plus
Instrument and computer. The test passes if the Real-Time PCR Software can
establish communication with the 7300Plus Instrument.

CCD - Tests the CCD camera in the 7300Plus Instrument. The test passes if
the camera can capture an image.

Filter Wheel — Tests the filter wheel in the 7300Plus Instrument. The test
passes if the filter wheel controller is running the correct version of
firmware.

Shutter — Tests the optic shutter of the 7300Plus Instrument. The test passes
if the shutter controller is running the correct version of firmware.

Lamp — Tests the halogen lamp of the 7300Plus Instrument. The test passes if
the lamp controller is running the correct version of firmware.

Thermal Cycler — Tests the thermal cycler sample block in the 7300Plus
Instrument. The test passes if the thermal cycler controller is running the
correct version of firmware.

When the Real-Time PCR Software completes a test, the software reports the
pass/fail status of the test and provides a description of the outcome.

Function Test E|
Test Pass/Fail Description
| LsE | Pass IUSE check passed.
| Cch | Pass [CCD check passed.
| Fitter Wheel | Pass |Fi|ter'u"u'hee| check passed.
| shuter | Pass iShutter check passed.
| Lamp | Pass Lamp check passed,
| Thermao Cycler | FPass IThEl'ml:l Cycler check passed.
|  muTests | Pass
| close |

3. When you finish testing, click Close.

Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide
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Monitor the lamp Use the Lamp Status/Replacement dialog box to monitor the status of the halogen
status lamp that the 7300Plus Instrument uses to illuminate samples during runs.
Check the lamp status

In the Real-Time PCR Software, select Instrument » Lamp Status/Replacement to
determine the status of the halogen lamp.

Lamp Status f Replacement g|
Current Lamp Status
Condition: Good
Llsage (Hours): i
Lamp Current: LInknown

Date Last Replaced: 10/01/2007
Replace Lamp

You mustresetthe lamp timer
after replacing the lamp.

[MOTE: The lamp timer can only ke
resetwhenthe instrumentis idle]

| Feset Lamp Timer

| Close |

The Lamp Status/Replacement dialog box displays:
¢ Condition - Indicates one of the following conditions:

— Good - The lamp is functioning well and does not need to be replaced. Click
Close.

— Failed - The lamp bulb must be replaced. Click Close, then replace the lamp
as explained in “Replace the halogen lamp” on page 54.

— Change Soon — The lamp usage is above 2000 hrs; Thermo Fisher Scientific
recommends that you replace it. Click Close, then decide whether or not to
replace the lamp. If you choose to replace the lamp, see “Replace the halogen
lamp” on page 54.

* Usage (Hours) — The total number of hours that the lamp has been illuminated.

* Lamp Current — The output current of the lamp in amperes (A). Low current can
indicate a potential future failure of the lamp.

¢ Date Last Replaced — The date of the last lamp replacement.

Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide 49
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Warnings

The Real-Time PCR Software can display the following warnings before or during a
run:

Message Description

The lamp current is below the acceptable
level at the start of the run. You cannot
proceed with the run until you replace the
halogen bulb as explained in “Replace the
halogen lamp” on page 54.

WARNING! Warning - Cannot
detect sufficient current from lamp.
Either lamp is not installed properly
or needs to be replaced.

The Real-Time PCR Software stopped the
run because the lamp current decreased
below the acceptable level during the run.
You cannot proceed with the run until you
replace the halogen bulb as explained in
“Replace the halogen lamp” on page 54.
Click OK in the message box, inspect the
Instrument Log, then replace the lamp
bulb.

A WARNING! Warning - Cannot
detect sufficient current from lamp.
Either lamp is not installed properly
or needs to be replaced.

The lamp usage exceeds 2000 hr at the
start of a run. Click Cancel Run, then
replace the lamp, or click Continue Run.

A WARNING! Warning - The lamp
usage has exceeded 2000 hr. We
recommend replacing the lamp
soon to ensure optimal assay Rerun ROI, Background, Optical and Dye
performance. calibrations.

Decontaminate the sample block

Perform the following procedure to eliminate fluorescent contaminants from the
sample block of the 7300Plus Instrument. Fluorescent contamination is generally
evident in failed background runs where one or more wells consistently exhibit
abnormally high signals.

A WARNING! PHYSICAL INJURY HAZARD. Do not remove the instrument
cover. There are no components inside the 7300Plus Instrument that you can
safely service yourself. If you suspect a problem, contact an Thermo Fisher
Scientific Service Representative.

i’i WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the
sample block can be heated to 100°C. Before performing the following
procedure, be sure to wait until the sample block reaches room temperature.

i’i WARNING! Before using a cleaning or decontamination method other than
those recommended by the Thermo Fisher Scientific, verify with Thermo Fisher
Scientific that the proposed method will not damage the equipment.

50 Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide
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Time required 30 min

i 95% ethanol  10% bleach
Materials solution solutiiic Safety ]
required - glasses Screwdriver

Cotton or nylon
swabs and
lint-free cloths

Pipette (100-pL)

with pipette tips Powder-free

gloves

Deionized
water

Clean the IMPORTANT! Wear powder-free gloves when you perform this procedure.
sampleblock
1. Identify the contaminated wells of the sample block (see “How to Identify
Contamination”).
2. Remove the plate and the tray holder from the 7300Plus Instrument:
a. Push the tray door to open it.
b. Remove the plate and the tray holder.
c. Close the tray door. Apply pressure to the right side of the tray door at an
angle.
ﬁ Push
3. Manually raise the block:
a. In the Real-Time PCR Software, select Instrument » Instrument
Maintenance Manager.
b. In the ROI tab of the Instrument Maintenance Manager, click Start Manual
Calibration.
c. In the ROI Inspector dialog box, click Move Block.
d. When the ROI Inspector dialog box displays “Block Down,” click Done.
4. Power off, then unplug the 7300Plus Instrument. Allow it to cool for 15 min.
5. Open the access door to the 7300Plus Instrument.
a. Insert a thin screwdriver into the keyhole on the edge of the access door,
then push to unlatch the door.
Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide 51
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b. Open the access door.

7. Clean the contaminated wells of the sample block using a small volume of
deionized water:

a. Pipette a small volume of deionized water into each contaminated well.
b. Pipette the water up and down several times to rinse the well.

c. Pipette the water to a waste beaker.

d. Using a cotton swab, scrub inside of each contaminated well.

e. Using a lint-free cloth, absorb the excess deionized water.

8. Pull the heated cover door to the front of the 7300Plus Instrument. Lift the latch,
then secure the heated cover door to the cross bar.

52 Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide
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Close the access door to the 7300Plus Instrument.

Plug in, then power on the 7300Plus Instrument.

Verify that you have eliminated the contamination by performing a background
calibration run (see “Perform the background calibration” on page 20).

If the contamination remains, repeat Clean the Sample Block on page 51 through
Clean the Sample Block on page 52, then clean the contaminated wells of the
sample block using 95% ethanol solution:

a. Pipette a small volume of 95% ethanol solution into each contaminated well.

b. In each contaminated well, pipette the solution up and down several times
to rinse the well.

c. Pipette the ethanol solution to a waste beaker.

IMPORTANT! Always use deionized water to rinse wells after cleaning with
bleach or ethanol solution.

Repeat Clean the Sample Block on page 52 through “Clean the sampleblock” on
page 51to rinse the wells of the sample block and to verify that you have
eliminated the contamination.

If the contamination remains, repeat steps 1 through 6, then clean the
contaminated wells of the sample block using 10% bleach solution:

a. Pipette a small volume of 10% bleach solution into each contaminated well.

b. In each contaminated well, pipette the solution up and down several times
to rinse the well.

c. Pipette the bleach solution to a waste beaker.

IMPORTANT! Always use deionized water to rinse wells after cleaning
with bleach or ethanol solution.

Repeat steps 7 through11 to rinse the wells of the sample block and to verify that
you have eliminated the contamination.

If the contamination remains, contact Thermo Fisher Scientific support (see
“How to Obtain Support”).

Ensure that the heated cover door is completely closed and latched. If it is not,
the Real-Time PCR Software displays an error message.
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Replace the halogen lamp

Replace the halogen lamp after approximately 2000 hr of life.

@ WARNING! PHYSICAL INJURY HAZARD. The 7300Plus Instrument and
lamp are hot! The lamp can become very hot while in use. Allow the lamp to
cool for 15 min and put on protective, powder-free gloves before handling it.

A WARNING! PHYSICAL INJURY HAZARD. Wear disposable, powder-free
gloves when handling the lamp to prevent burns and to prevent shortening the
life of the replacement lamp.

A WARNING! WARNING. This instrument is designed for 12 V, 75 W halogen
lamps only.

Time required 30 min

Materials
required N =
4
Halogen bulb  Screwdriver, Safety
12V, 75 W) small gloves glasses

Replace the lamp IMPORTANT! Wear powder-free gloves when you handle the lamp.

1. Power off, then unplug the 7300Plus Instrument. Allow the instrument to cool
for 15 min.

2. Open the access door to the 7300Plus Instrument:

a. Insert a thin screwdriver into the keyhole on the edge of the access door,
then push to unlatch the door.

b. Open the access door.

.

Aﬂh

3. Remove the lamp from the instrument:

a. Slide the lamp release lever downward.

54 Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide
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b. Firmly grasp the lamp and lift it up and out of the slotted mount.

IMPORTANT! Do not touch the lamp without powder-free gloves. Finger
prints shorten the lamp life.

4. Inspect the lamp for signs of failure (carbon typically coats the inside of failed
lamps).

Good bulb

Failed bulb
Replace

5. Install the new lamp into the instrument:
a. Slide the lamp release lever upward.

b. Firmly grasp the lamp, place it into the slotted mount, then carefully slide
the lamp downward into place.

6. Close the access door.

7. Plugin and power on the 7300Plus Instrument.
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8. Open the ROI Inspector dialog box:

a. In the Real-Time PCR Software, select Instrument » Instrument
Maintenance Manager.

b. In the ROI tab of the Instrument Maintenance Manager, click Start Manual
Calibration.

9. In the ROI Inspector dialog box, select Lamp Control » Idle.

10. While the instrument is running, look through grating of the access door and
verify that the lamp is illuminated, then click Done.

==
—==—==———— " Light should be
| visible

11. If the lamp is illuminated, select Instrument » Lamp Status/Replacement in the
Real-Time PCR Software, click Reset Lamp Timer, then click OK.

If the lamp is not illuminated, the replacement halogen lamp may be defective.
Replace the lamp again. If the second lamp does not illuminate, check the
instrument fuses for failure (see page 66).

12. Perform the following calibrations after replacing the lamp. See:
¢ Chapter 2, “Perform the Regions of Interest (ROI) Calibration”
* Chapter 3, “Perform the Background Calibration and Optical Calibration”
¢ Chapter 4, “Perform the Dye Calibration”
¢ Chapter 5, “Verify Instrument Performance”

Replace the instrument fuses

Replace the 7300Plus Instrument fuses when the fuses fail.

@ WARNING! FIRE HAZARD. For continued protection against the risk of fire,
replace fuses only with listed and certified fuses of the same type and rating as
those currently in the instrument.

Time required 30 min
Materials ‘
required $® 2 3 R
\ e
1 2Fg sAe32(528 'y Flathead Powder-free Safety
5x 20 mm  Screwdriver gloves glasses
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Replace the fuses 1. Power off the instrument, then unplug it.

DANGER! ELECTRICAL SHOCK HAZARD. Severe electrical shock,
which could cause physical injury or death, can result from working on an
instrument when the high voltage power supply is operating. To avoid
electrical shock, disconnect the power supply to the instrument, unplug
the power cord, and wait at least 1 minute before working on the
instrument.

2. Using a flat-head screwdriver, unscrew and remove the fuse holders from the
instrument.

3. Remove each fuse from its fuse holder and inspect it for damage. Carbon
typically coats the inside of failed fuses.

Good fuse
Qa1

ﬁi« Failed fuse

[ 3 Replace

4. Replace each failed fuse with a 12.5 A, 250 V, 5 - 20-mm fuse.

Note: The voltage and amperage ratings are on the fuse holder.

5. Install the fuse holder.
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Update the Windows Operating System

6. Plugin, then power on the instrument.
The installation is successful if the instrument powers on.

Note: Fuse failure can result from fluctuations in the supplied power to the
instrument. To prevent further failures, consider installing an electrical
protective device, such as a UPS or other surge protector. For more information
about fuses, see the Applied Biosystems® 7300Plus Real-Time PCR Instrument
Site Preparation Guide.

Update the Windows Operating System

Determine
compatibility of an
upgrade or update

Do not upgrade or update the Microsoft Windows operating system of the computer
running the Real-Time PCR Software without first consulting the software release
notes or the Thermo Fisher Scientific website. Future versions of the Windows
operating system and updates to the operating system can conflict with the Real-Time
PCR Software.

1. Open D:\Applied Biosystems\ Real-Time PCR Software , double-click release-
notes.html, then read the N/A Release Notes for the compatibility of interest.

2. If the release notes do not mention the compatibility, use an internet browser to
visit www.lifetechnologies.com, then search the website for the compatibility of

interest.

3. If the website does not contain the information of interest, contact Support.

Update the Real-Time PCR Software

Visit the website

Prepare for the
upgrade

58

If you want to update the Real-Time PCR Software, prepare your computer by
exporting the application libraries and backing up your experiment files.

You can obtain Real-Time PCR Software updates directly from the service section of
the Applied Biosystems website. For the latest services and support information for
the 7300Plus Instrument:

1. Go to www.lifetechnologies.com/support

2. In the Software Downloads page, select the appropriate instrument from the
drop-down list.

3. In the Software Downloads page for your instrument, click Updates - Patches.

The website opens the page describing the latest software updates.

Before updating the Real-Time PCR Software:

1. Back up the application libraries:

a. In the main menu of the Real-Time PCR Software, select Tools<desired
library>.
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b. When the library dialog box opens, select the element(s) that you want to
export, then click Export.

c. In the Export dialog box, click Save to archive the selected records.
d. Repeat steps 1a through 1c for the remaining libraries to archive them.

2. Back up all experiment files by creating a copy of the directory that you are using
to store files.

The default directory for experiments is:
D:\ Applied Biosystems\Real-Time PCR Software \ experiments
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Store, Move, and Install the
7300Plus Instrument

Store the 7300Plus Instrument . ........... ..ot 60
Move the 7300Plus Instrument . ... 61
Set Up the 7300Plus Instrument ........... .. ..., 62

Note: For more information about any of the topics discussed in this guide, access the
Help from within Real-Time PCR Software by pressing F1, clicking & in the toolbar,
or selecting Help » Real-Time PCR Software Help.

Store the 7300Plus Instrument

The Applied Biosystems® 7300Plus Real-Time PCR Instrument can be powered off
and stored for extended periods of time. The length of the period of inactivity
determines the method you use to power off the instrument.

Time required 5 min
Materials MicroAmp® Optical 96-Well Reaction Plate (unused)
required
Prepare the 1. Open the instrument tray door.
instrument

2. If the tray contains a plate, remove it.
3. If you plan to store the 7300Plus Instrument for more than a week or you plan to
move the instrument, load an unused plate into the tray.

Note: The empty plate protects the internal components of the 7300Plus
Instrument during transport or during periods of inactivity lasting more than a
week.

4. Push the tray door to move it into the instrument.

5. Press the instrument power button.

60 Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide
For Research Use Only. Not for use in diagnostic procedures.



Appendix A Store, Move, and Install the 7300Plus Instrument
Move the 7300Plus Instrument

6. Power off the computer and monitor:
a. Select Start » Shut Down.

b. In the Shut Down Windows dialog box, select Shut Down.

c. Power off the monitor.

Move the 7300Plus Instrument

Perform this procedure to safely move the 7300Plus Instrument short distances (for
example, between laboratories of the same building).

WARNING! PHYSICAL INJURY HAZARD. Do not attempt to lift the
instrument or any other heavy objects unless you have received related
training. Incorrect lifting can cause painful and sometimes permanent back
injury. Use proper lifting techniques when lifting or moving the instrument. At
least 2 people are required to lift the 7300Plus Instrument.

IMPORTANT! Moving your Applied Biosystems® 7300Plus Real-Time PCR
Instrument can create subtle changes in the alignment of the instrument optics.

Materials MicroAmp® Optical 96-Well Reaction Plate (unused)

required
Prepare the 1. Load the empty reaction plate into the 7300Plus Instrument.
instrument

2. Using the ROI Inspector, manually raise the sample block:

a. In the Real-Time PCR Software, select
InstrumentInstrument Maintenance Manager.

b. In the ROI tab of the Instrument Maintenance Manager,
click Start Manual Calibration.

c. In the ROI Inspector dialog box, click Block Up.
3. Power off the 7300Plus Instrument and computer.
4. Disconnect all 7300Plus Instrument components.

5. Move the 7300Plus Instrument according to the following guidelines:

¢ Verify that the surface on which you will place the instrument can support
at least 54.5 kg (120 Ibs).

¢ Verify that the pathway to the final position of the instrument is clear of
obstructions.

* Keep your spine in a good neutral position.
¢ Bend at the knees and lift with your legs.
* Do not lift an object and twist your torso at the same time.

¢ Coordinate your intentions with your assistant before lifting and carrying.
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Set Up the 7300Plus Instrument

Reconnect the components of the 7300Plus Instrument (see “Set Up the 7300Plus
Instrument” on page 62).

Run a TagMan® RNase P Instrument Verification Plate (see “Run the
experiment” on page 40).
a. If the run passes, recalibrations are not necessary.

b. If the run fails, perform steps 8 through 12 to recalibrate the instrument.

4 RNase P Run

RNase P Analysis

&

Analysis Help @)

- Setup

and apply the rasuits

3

|

- Run Status: Passed

I“I

a Instructions: Review the results from the RNase P run. fthe run failed, omit outliers, then click "Reanalyze " Repeat until the run passes. Click Finish to save

| Analysis Settings |

| omit || Reanalyze

< | View Plate LaynutT Results Table }
>

Select Wells With: |- Select tem - v | |

~ Analysis Amplification Plot | Standard Curve
= Plot Seftings
Target Al v|  Piotcolor Defaut v
a k=

Standard Curve

ct

]
ks o

Quantity

Target: RNase P Slope: -3.502 Y-Inter: 40.933 EZZ 0.998 Eff%: 93.012 —

h standard [l Unknown [l Unknown (Flagged)

-a00aoaooooon)
- BEO0E0000000
-A00000000000
-A000000a00000|
‘300000000000
-a00aaaaaooo)
- | I e N R

welis: [T 72 Unknown [5] 20 Standard [1] 4 Megative Control 0 Empty

| cancel | | Previous | | Nest | | |

8. Perform an ROI calibration (see page 13).

9. Perform a background calibration (see page 23).

10. Perform an optical calibration (see page 25).

11. Perform a dye calibration (see page 32).

12. Perform an instrument verification run (see page 45).

Set Up the 7300Plus Instrument

Set up the Refer to the Applied Biosystems Real-Time System Computer Setup Guide for
computer information on setting up a computer for use with the 7300Plus Instrument.
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Set Up the 7300Plus Instrument

Set up the IMPORTANT! Do not connect the USB cable to the 7300Plus Instrument until you are
7300Plus instructed to do so by this guide.
Instrument
Materials required
¢ Phillips screwdriver (small and thin)
* Power cord
Set Up the 7300PLlus Instrument

1. Prepare the installation site as described in the 7300PIus Real-Time PCR
Instrument Site Preparation Guide.

2. Open the access door to the 7300Plus Instrument.

a. Insert a thin screwdriver into the keyhole on the edge of the access door,
then push to unlatch the door.
b. Open the access door.

3. Verify that the heated cover assembly is pulled fully toward the front of the
instrument. If the 7300Plus Instrument has a heated cover latch installed, check
that the latch is in a locked position.

4. Inspect the instrument for damage caused by the transportation of the 7300Plus
Instrument.

If the instrument is damaged, record the location and appearance of the damage,
then contact Support or your service representative for assistance.

5. Close the access door.

6. Connect the power cord to the 7300Plus Instrument, then to the wall receptacle.

7. Press the power button at the lower right front panel, then wait for the 7300Plus
Instrument to start up (about 30 sec).

8. When the Power status light on the lower left front panel is lit, push the tray
door to open it.

9. Remove the packaging plate from the tray and set it aside.

10. Close the tray door, then press the power button again to power off the
instrument.
Note: Install any additional hardware.
IMPORTANT! Do not connect the USB cable to the 7300Plus Instrument at this
time.
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Set Up the 7300Plus Instrument

11. Verify that the Real-Time PCR Software is installed to the computer.

If the computer does not have the Real-Time PCR Software, use the Real-Time
PCR Software CD to install the software.

12. Once you verify that the computer contains the Real-Time PCR Software, connect
the USB cable to the 7300Plus Instrument.
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Before using custom dyes ............ . il 65
Materials required . .......... . 66
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Create a custom dye plate ............... i 69
Add the custom dye to the software ........... ... ... 70

The Applied Biosystems® 7300Plus Real-Time PCR Instrument can be used to run
assays designed with custom dyes (dyes not manufactured by Thermo Fisher
Scientific). Custom dyes must fluoresce within the 520 to 650 nm spectral range
measured by the 7300Plus Instrument.

Before using custom dyes

Before using custom dyes with the 7300Plus Instrument, you must:
* Determine optimum dye concentration
* Create a custom dye plate
* Add the custom dye to the software
¢ Perform a dye calibration (see Chapter 4, “Perform the Dye Calibration”)
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Appendix B Create a Custom Dye Plate

Materials required

Materials required

Pipettors and
pipette tips
(200-pL and 1000-pL)

Water, Tubes Safety
deionized (2-mL and 10-mL) glasses
Custom

= *

]

ABI Prism® Optical 96-Well Optical Adhesive Cover Powder-free

Reaction Plate or Optical Flat Caps gloves

Centrifuge with plate adapter

Dilute the custom dye to an optimal concentration

Custom dye
dilution guidelines

66

Use the following guidelines to prepare a dilution series for each custom dye:

Target several dye concentrations within a range of 100-2000 nM.
Choose a 2- or 3-fold difference in dilution points.
Use a recommended volume of 50 pL/well.

Dilute the dye in buffer that is compatible with your master mix. See Appendix
C, “Create a Background Plate”for detailed instructions for preparing a
background plate using the buffer provided with your custom dye.

(Intercalating dyes only) Add the appropriate amount of amplified PCR product to
generate fluorescence.
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Dilute the custom dye to an optimal concentration

Prepare a custom

e IMPORTANT! Wear powder-free gloves while creating the dye plate.
dye dilution plate

Prepare and load the custom dye dilution plate:

1. Prepare a dilution series of the custom dye following the dilution guidelines.

2. Pipet the appropriate volume of the dilution series to the center of a 96-well
plate, then seal the plate.
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c
=
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= = = = &
oy = oy oy [=)
e o o o (=] et
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3. Vortex the plate for 5 seconds, then centrifuge it for 2 minutes at 750 - 1000g.
Confirm that the liquid in each well of the plate is at the bottom of the well. If

not, centrifuge the plate again at a higher rpm and for a longer period of time.

4. Load the plate into the instrument.

Run the dilution Run the custom dye dilution plate as a new experiment:

plate as an 1

) . On the Home screen of your system software, create a new Genotyping
experiment

experiment and uncheck Pre-PCR Read and Amplification.

2. Enter the required experiment properties, then add the dilution series
information to the appropriate wells in the plate layout.
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Dilute the custom dye to an optimal concentration

3. Edit the run method to include a Post-PCR Read with a 1 minute hold. Make sure
to enter the appropriate reaction volume and select the filters of interest.
For example:

Run Method

a Review the reaction volume and the thermal prot

Graphical View | Tabular View

Reaction Volume Per Well 50 uL [T Exped

Add Stage ¥ | Add Step ¥ |

Post-PCR Read (Holding Stage))

100 —|

60.0 °C
A —
01:00

00%

o —|

Step 1

«

Legend
Data Collection On Data Collection Off 4

4, Save the experiment and start the run.

Determine the Review the run results and select the dilution to calibrate:

0pt|ma'£ dyte 1. When the run is complete, review the dye signal data:

concentration a. In the Analysis area of your system software, select the Raw Data Plot.
This plot displays the raw fluorescent signal of each dye as detected through
each emission filter, for individual wells during the Post-PCR read.
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Create a custom dye plate

b. For each replicate population of dilutions, select the wells in the Plate
Layout tab to view in the plot. For example:

Raw Data Plot

c. Examine the raw data and identify the well(s) yielding signals according the
ranges shown in the following table, then select the lowest (optimal) dye
concentration that falls within the acceptable signal range:

Plate type Acceptable signal range
96-well 1,000,000-12,000,000

Note: You can also export the raw data and average for the various
concentrations.

2. Unload the plate from the instrument and discard the plate.

WARNING! PHYSICAL INJURY HAZARD. During system operation,
the plate can reach 100°C. Allow the plate to cool to room temperature
before removing.

Create a custom dye plate

IMPORTANT! Wear powder-free gloves while creating the dye plate.

1. Prepare at least 5 mL of the custom dye at the concentration determined in step
8.

2. Pipette 50 pL of the diluted custom dye to all wells of an optical reaction plate.

3. Seal the wells of the reaction plate using an optical adhesive cover.

Applied Biosystems® 7300Plus Real-Time PCR Instrument User Guide 69
For Research Use Only. Not for use in diagnostic procedures.



Appendix B Create a Custom Dye Plate
Add the custom dye to the software

4. Centrifuge the plate for 2 min at 750 - 1000 g.

IMPORTANT! The custom dye calibration plate must be well mixed and
centrifuged.

5. Verify that the liquid in each well of the custom dye plate is at the bottom of the
well. If not, centrifuge the plate again at a higher rpm and for a longer period of

time.
Correct Incor rect
\ Liquid is at » Not centrifuged with enough force,
bottom of well. or

» Not centrifuged for enough time

Add the custom dye to the software

1. In the main screen of the Real-Time PCR Software, select Instrument>
Instrument Maintenance Manager.

2. In the Instrument Maintenance Manager:

a. In the navigation pane, click Dye.
b. In the Dye screen, select Custom Dye Calibration.
c. Click Start Calibration.

3. In the Setup screen of the Dye Calibration dialog box, select a custom dye from
the list or create the custom dye as follows:

a. Click New Dye.
b. Inthe Dye Manager dialog box, click New.

c. Complete the New Dye dialog box, then click OK.

Field/Option Action
Name Enter a name for the custom dye.
Wavelength Enter the wavelength at which the dye fluoresces.
Select:

e Reporter if the dye works in conjunction with a
quencher dye to report an increase of PCR product.

Type e Quencher if the dye suppresses the fluorescence of a
reporter dye until amplification of PCR product.

e Both if the dye reports an increase of PCR product
without the aid of a quencher dye.

d. Click Close.
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Add the custom dye to the software

4. In the Setup screen of the Dye Calibration dialog box, enter a temperature setting
for the calibration.

Note: Set the temperature to match the temperature at which you intend to
collect data. For example, the temperature for all Applied Biosystems system
dyes is 60°C because data collection for TagMan® reagents occurs during the
60°C extension step of the PCR.

5. Select The custom dye plate is loaded in the instrument, then click Next.
6. In the Run screen, click Start Run, then wait for the 7300Plus Instrument to

complete the dye calibration.

Note: If the Real-Time PCR Software displays messages during the run,
troubleshoot the errors as described in “Troubleshoot the dye calibration” on
page 36.

7. When the 7300Plus Instrument displays the Main Menu, unload the custom
calibration plate.

8. Analyze the custom spectral calibration as explained in “Analyze the calibration
data” on page 33.
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Materials required . .......... . . 72
Create a background plate ........ ... ... . 72

Whenever possible, use a background plate that is included with the spectral
calibration kit. The plates supplied in the kit contain a buffer that accurately simulates
the reagents used for PCR, and, therefore, produces high-quality calibration data.
However, if a background plate from a spectral calibration kit is not available, you
can create one as described below.

Materials required

Pipettor, 200-uL Deionized
(with pipette tips) water Safety glasses

Z 4

Applied Biosystems Optical Optical Adhesive Powder-free
96-Well Reaction Plate Cover or Optical gloves

Flat Caps

Create a background plate

IMPORTANT! Wear powder-free gloves while creating the background plate.

1. Remove an Applied Biosystems 96-Well Optical Reaction Plate from its box and
place it on a clean, dry surface.

2. Aliquot 50 pL of deionized water to each well of the reaction plate.

3. Seal the plate using an optical adhesive cover or optical flat caps.

Use the plate for background calibration in the same way you use a background
plate from the spectral calibration kit. See Chapter 3, “Perform the Background
Calibration and Optical Calibration”
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WARNING! GENERAL SAFETY. Using this product in a manner not specified
in the user documentation may result in personal injury or damage to the
instrument or device. Ensure that anyone using this product has received
instructions in general safety practices for laboratories and the safety
information provided in this document.

- Before using an instrument or device, read and understand the safety
information provided in the user documentation provided by the
manufacturer of the instrument or device.

- Before handling chemicals, read and understand all applicable Safety Data
Sheets (SDSs) and use appropriate personal protective equipment (gloves,
gowns, eye protection, etc). To obtain SDSs, see the “Documentation and
Support” section in this document.
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Symbols on this instrument

Symbols on this instrument

74

Symbols may be found on the instrument to warn against potential hazards or convey
important safety information. In this document, the hazard symbol is used along with
one of the following user attention words:

e CAUTION! - Indicates a potentially hazardous situation that, if not avoided,
may result in minor or moderate injury. It may also be used to alert against
unsafe practices.

* WARNING! - Indicates a potentially hazardous situation that, if not avoided,
could result in death or serious injury.

¢ DANGER! - Indicates an imminently hazardous situation that, if not avoided,
will result in death or serious injury.

Symbol | English Francais
A Caution, risk of danger Attention, risque de danger
Consult the manual for further safety | Consulter le manuel pour d’autres
information. renseignements de sécurité.
Caution, risk of electrical shock Attention, risque de choc électrique

Caution, hot surface Attention, surface chaude

On/Off On/Off [marche/arrét)

Protective conductor terminal (main |Borne de conducteur de protection
ground]) (mise a la terre principale)

/N
é Moving parts Parties mobiles
/N
)
&)
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Safety alerts on this instrument

Symbol

English

Francais

|3

Do not dispose of this product in
unsorted municipal waste

CAUTION! To minimize
negative environmental
impact from disposal of
electronic waste, do not
dispose of electronic waste in
unsorted municipal waste.
Follow local municipal waste
ordinances for proper
disposal provision and
contact customer service for
information about
responsible disposal options.

Ne pas éliminer ce produit avec les
déchets usuels non soumis au tri
sélectif.

CAUTION! Pour minimiser
les conséquences négatives
sur l'environnement a la suite
de l'élimination de déchets
électroniques, ne pas
éliminer ce déchet
électronique avec les déchets
usuels non soumis au tri
sélectif. Se conformer aux
ordonnances locales sur les
déchets municipaux pour les
dispositions d"élimination et
communiquer avec le service
a la clientele pour des
renseignements sur les
options d’élimination
responsable.

Safety alerts on this instrument

Additional text may be used with one of the symbols described above when more
specific information is needed to avoid exposure to a hazard. See the following table
for safety alerts found on the instrument.

English

CAUTION! Hazardous chemicals. Read the Safety Data Sheets (SDSs) before
handling.

CAUTION! Hazardous waste. Refer to SDS(s) and local regulations for handling
and disposal.

DANGER! High voltage.

> BBk P

WARNING! To reduce the chance of electrical shock, do not remove covers that
require tool access. No user-serviceable parts are inside. Refer servicing to
Thermo Fisher Scientific qualified service personnel.
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Safety information for instruments not manufactured by Thermo Fisher Scientif-
ic

Location of safety The Applied Biosystems® 7300Plus Real-Time PCR Instrument contains warnings at
labels on this the following locations.

instrument

‘ A Attention
I A Physical hazard

A Physical hazard
A Attention

Safety information for instruments not manufactured by Thermo
Fisher Scientific

Some of the accessories provided as part of the instrument system are not designed or
built by Thermo Fisher Scientific. Consult the manufacturer's documentation for the
information needed for the safe use of these products.
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Instrument safety

Instrument safety

General A CAUTION! Do not remove instrument protective covers. If you remove the
protective instrument panels or disable interlock devices, you may be exposed
to serious hazards including, but not limited to, severe electrical shock, laser
exposure, crushing, or chemical exposure.

Physical injury A CAUTION! Moving and Lifting Injury. The instrument is to be moved and
positioned only by the personnel or vendor specified in the applicable site
preparation guide. Improper lifting can cause painful and permanent back
injury.

Things to consider before lifting or moving the instrument or accessories:

- Depending on the weight, moving or lifting may require two or more
persons.

- If you decide to lift or move the instrument after it has been installed, do not
attempt to do so without the assistance of others, the use of appropriate
moving equipment, and proper lifting techniques.

- Ensure you have a secure, comfortable grip on the instrument or accessory.

- Make sure that the path from where the object is to where it is being moved
is clear of obstructions.

- Do not lift an object and twist your torso at the same time. Keep your spine
in a good neutral position while lifting with your legs.

- Participants should coordinate lift and move intentions with each other
before lifting and carrying.

- For smaller packages, rather than lifting the object from the packing box,
carefully tilt the box on its side and hold it stationary while someone else
slides the contents out of the box.

Ae CAUTION! Moving Parts. Moving parts can crush, pinch and cut. Keep hands
clear of moving parts while operating the instrument. Disconnect power before
servicing.
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Safety and electromagnetic compatibility [EMC) standards

Electrical A WARNING! Fuse Installation. Before installing the instrument, verify that the
fuses are properly installed and the fuse voltage matches the supply voltage.
Replace fuses only with the type and rating specified for the unit. Improper
fuses can damage the instrument wiring system and cause a fire.

A WARNING! Voltage Selector Switch. Before installing the instrument, verify
that the voltage selector switch is set for the supply voltage. This will prevent
damage to the instrument, reduce risk of fire, and enable proper operation.

A WARNING! Ensure appropriate electrical supply. For safe operation of the
instrument:

- Plug the system into a properly grounded receptacle with adequate current
capacity.

- Ensure the electrical supply is of suitable voltage.

- Never operate the instrument with the ground disconnected. Grounding
continuity is required for safe operation of the instrument.

A WARNING! Power Supply Line Cords. Use properly configured and approved
line cords for the power supply in your facility.

A WARNING! Disconnecting Power. To fully disconnect power either detach or
unplug the power cord, positioning the instrument such that the power cord is
accessible.

Cleaning E?nd . A CAUTION! Cleaning and Decontamination. Use only the cleaning and

decontamination decontamination methods specified in the manufacturer's user documentation.
It is the responsibility of the operator (or other responsible person) to ensure
the following requirements are met:

- No decontamination or cleaning agents are used that could cause a
HAZARD as a result of a reaction with parts of the equipment or with
material contained in the equipment.

- The instrument is properly decontaminated a) if hazardous material is
spilled onto or into the equipment, and/or b) prior to having the instrument
serviced at your facility or sending the instrument for repair, maintenance,
trade-in, disposal, or termination of a loan (decontamination forms may be
requested from customer service).

- Before using any cleaning or decontamination methods (except those
recommended by the manufacturer), users should confirm with the
manufacturer that the proposed method will not damage the equipment

Safety and electromagnetic compatibility (EMC) standards

The instrument design and manufacture complies with the standards and
requirements for safety and electromagnetic compatibility as noted in the following
table:
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EMC

Environmental
design
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Safety and electromagnetic compatibility [EMC) standards

Reference Description
IEC 61010-1 Safety requirements for electrical equipment for measurement,
UL 61010-1 control, and laboratory use - Part 1: General requirements
CSA C22.2 No.
61010-1

IEC 61010-2-010

Safety requirements for electrical equipment for measurement,
control and laboratory use — Part 2-010: Particular requirements
for laboratory equipment for the heating of materials

IEC 61010-2-081

Safety requirements for electrical equipment for measurement,
control and laboratory use — Part 2-081: Particular requirements
for automatic and semi-automatic laboratory equipment for
analysis and other purposes

Reference

Description

IEC 61326-1

Electrical Equipment for Measurement, Control and Laboratory
Use - EMC Requirements - Part 1: General Requirements

AS/NZS 2064

Limits and Methods of Measurement of Electromagnetic
Disturbance Characteristics of Industrial, Scientific, and Medical
(ISM] Radiofrequency Equipment

Reference

Description

Directive 2012/19/EU

European Union “WEEE Directive” - Waste electrical and
electronic equipment
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Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards,
ensure laboratory personnel read and practice the general safety guidelines for
chemical usage, storage, and waste provided below, and consult the relevant
SDS for specific precautions and instructions:

- Read and understand the Safety Data Sheets (SDSs) provided by the

chemical manufacturer before you store, handle, or work with any chemicals
or hazardous materials. To obtain SDSs, see the “Documentation and
Support” section in this document.

- Minimize contact with chemicals. Wear appropriate personal protective

equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing).

- Minimize the inhalation of chemicals. Do not leave chemical containers open.

Use only with adequate ventilation (for example, fume hood).

- Check regularly for chemical leaks or spills. If a leak or spill occurs, follow

the manufacturer's cleanup procedures as recommended in the SDS.

. Handle chemical wastes in a fume hood.

- Ensure use of primary and secondary waste containers. (A primary waste

container holds the immediate waste. A secondary container contains spills
or leaks from the primary container. Both containers must be compatible
with the waste material and meet federal, state, and local requirements for
container storage.)

- After emptying a waste container, seal it with the cap provided.
- Characterize (by analysis if necessary) the waste generated by the particular

applications, reagents, and substrates used in your laboratory.

- Ensure that the waste is stored, transferred, transported, and disposed of

according to all local, state/provincial, and/or national regulations.

- IMPORTANT! Radioactive or biohazardous materials may require special

handling, and disposal limitations may apply.

WARNING! HAZARDOUS WASTE (from instruments). Waste produced by
the instrument is potentially hazardous. Follow the guidelines noted in the
preceding General Chemical Handling warning.
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Biological hazard safety

@ WARNING! Potential Biohazard. Depending on the samples used on this
instrument, the surface may be considered a biohazard. Use appropriate
decontamination methods when working with biohazards.

& WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,
infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. All work should be conducted in properly
equipped facilities using the appropriate safety equipment (for example,
physical containment devices). Safety equipment also may include items for
personal protection, such as gloves, coats, gowns, shoe covers, boots,
respirators, face shields, safety glasses, or goggles. Individuals should be
trained according to applicable regulatory and company/ institution
requirements before working with potentially biohazardous materials. Follow
all applicable local, state/provincial, and/or national regulations. The following
references provide general guidelines when handling biological samples in
laboratory environment.

- U.S. Department of Health and Human Services, Biosafety in Microbiological
and Biomedical Laboratories (BMBL), 5th Edition, HHS Publication No. (CDC)
21-1112, Revised December 2009; found at:
www.cdc.gov/biosafety/publications/bmbl5/BMBL.pdf

- World Health Organization, Laboratory Biosafety Manual, 3rd Edition,
WHO/CDS/CSR/LYO/2004.11; found at:

www.who.int/csr/resources/publications/biosafety/Biosafety7.pdf
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Documentation and support

Related documentation

The following related documents are shipped with the system:

Document LIl Description
number

7300Plus Real-Time PCR 100027704 Provides the reference for accessing
Instrument Documentation user documentation from the product
website and contact details for service
and technical support.

Applied Biosystems® Real- N/A Explains how to use the Real-Time
Time PCR Software Help PCR Software to:

e Setup, run, analyze, export, and
print experiments.

e Monitor 7300Plus Instruments.

e Calibrate and verify the
performance of the 7300Plus
Instruments.

Intended for laboratory staff and
principal investigators who perform
experiments using the Real-Time PCR
Software.

7300Plus Real-Time PCR 100027692 Explains how to prepare your site to
Instrument Site Preparation receive and install the 7300Plus

Guide Instruments. Intended for personnel
who schedule, manage, and perform
the tasks required to prepare your site
for installation of the 7300Plus
Instruments.

Note: For additional documentation, see “Customer and technical support” on
page 83.
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Obtaining information from the Help system

The Applied Biosystems® 7300Plus Real-Time PCR Instrument has a Help system that
describes how to use each feature of the user interface. Access the Help system by
doing one of the following;:

¢ (lick in the toolbar of the Real-Time PCR Software window.
* Select Help » Contents and Index.
e DPress F1.

You can use the Help system to find topics of interest by:
* Reviewing the table of contents
* Searching for a specific topic
¢ Searching an alphabetized index

You can also access PDF versions of all documents in the 7300Plus Instrument
document set from the Help system.

Customer and technical support

Visit www.lifetechnologies.com/support for the latest in services and support,
including;:
¢ Worldwide contact telephone numbers
* Product support, including;
— Product FAQs
— Software, patches, and updates
* Order and web support
* Product documentation, including:
— User guides, manuals, and protocols
— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers,
contact the manufacturer.

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth
in the Life Technologies' General Terms and Conditions of Sale found on Life
Technologies' website at www.lifetechnologies.com/termsandconditions. If you have
any questions, please contact Life Technologies at www.lifetechnologies.com/
support.
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